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NAVIGATION TIPS
Use your keyboard cursor keys to
move to next page (cursor right)
or previous page (cursor left)
You can zoom in with
Ctrl/Cmd+ (plus)
and zoom out with
Ctrl/Cmd - (minus)
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#1
Using Colours in Stock Photo as a shared palette across Adobe CS2 applications #2
Using music to animate layers with Adobe After Effects #3
Give your footage the “Sin City” look with After Effects #4
Using Dynamic Slide Show, TV Output and Photo Mail with Photshop Elements 4.0 #5
Using Adobe Acrobat 7.0’s Tracker to Read RSS News Feeds #6
Using Digital IDs to secure communication #7
Using Adobe Stock Photos as Part of your InDesign Workflow

Adobe Premiere Elements 2.0
Easy Editing – Whether you’re brand new to
moviemaking or have just outgrown the limitations of
your current video software, get results with an intuitive
interface and automated features.
Sensational Sound – Audio thrills the video star through
full compatibility with the latest standards and total
attention to sound detail.
Terrific Titles – Subtitles, opening and closing credits, text
anywhere on the screen – Adobe Premiere Elements 2.0
makes it easy to add high-style, professional-quality titles
Share Spectacular Videos – Your Way – Choice of
delivery. Create a custom DVD or videotape, save an
optimised video for Web or email, or transfer them to your
portable video player to show on the go.

Honing skin tones – One
of the trickiest tasks for
any photographer is colour
balancing their photos especially making skin tones
After
look natural. The new Adjust Before		
Colour for Skin Tone feature contains three specialised
sliders for isolating and fine-tuning the appearance of skin
tones in photos.
Auto face tagging – Adding extra power for cataloguing
photos this feature automatically locates the faces in
your pictures. The Find Faces for Tagging option finds and
displays all the faces in a group of photos in a new dialog
ready for speedy tagging.
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What’s New:
At A Glance

Magical selection with a few strokes – The Magic
Selection Brush tool creates amazingly accurate selections
as the user draws on the areas of the picture that they
want to include. Photoshop Elements 4.0 analyses the
colour, texture and tone of
the picture part and creates
a selection based on these
factors. Fine tune the results
by adding extra painted
areas or removing unwanted
Before		
After
sections the same way.

HOLLYWOOD

Red Eye correction on the fly – You read right! As the
files are downloading, select Automatically Fix Red Eye in
any of the Add Photos dialogs and Photoshop Elements
4.0 finds the photos that have been taken with flash (via
settings in the associated metadata) and locates and
corrects any evidence of red eye in the picture.
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Revamped Slide Show Editor – Beyond standard PDF
presentations; you can add pan and zoom effects, a music
soundtrack, your own narration, title slides and graphics.
Select your audience’s preference: optimal for email, web,
VCD or even DVD viewing.
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Centre (Windows XP) start menu to More Programs.
Choose the Photoshop Elements 4.0 icon and then select
OK on your remote control.
STEP #2: At the Home screen, click Slide Show. Select
a saved multimedia slide show to play on your TV. Click
Home to return to the Home screen.
STEP #3: At the Home screen, click View Photos to
view individual photos and Collections or to search your
catalogue by date or tag.
STEP #4: Create an instant slide show with automatic
timing and transitions by clicking Play Slide
Show (change the speed or transition
by clicking Settings at the Home
screen).
STEP #5: Once photos and slide
shows have been viewed, using your
Home Media Centre, your recently
viewed images will be available on
the first screen.

Instead of merely attaching photos to a message, Photo
Mail gives your email style, with themed layouts. Photos
are inserted directly into the email message.
STEP #1: Select any four photos in the Photo Browser.
Click the Share button and choose Email.
STEP #2: In the next window, choose recipients for
the email or create new ones with the Add Recipient
button. Enter a custom message in the Message box. Click
Stationery & Layouts to choose a theme and layout for
your Photo Mail. Click Next Step and customise the layout.
STEP #3: Click Done to return to the main Attach
window, then click OK. Your email application opens
automatically with your new Photo Mail message. Send
the message
as you would
any other
completed
email and
you’re done!
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and choose Audio from Organiser. Choose a song from
the list and click OK. The song appears in the soundtrack
area below the Timeline thumbnails and by default will
be repeated for the duration of the slide show. Repeat
this step to add additional songs, drag the ends of songs
in the soundtrack to shorten their duration, or drag the
songs themselves to position them precisely under
certain photos. You can also click the Fit Slides to Audio
button to adjust the slide show to match the length of the
music soundtrack.
STEP #9: If you have a microphone attached to your
computer, click the Narration button in the Extras palette,
select a photo in the Timeline and directly record voice
narration for the slide.
STEP #10: To set transitions between slides, click the
arrow at the right side of a Transition thumbnail in the
Timeline and choose from the menu. Click the Transition
thumbnail to adjust its settings in the Properties palette.
STEP #11: To add text captions to any slide, select it in
the Timeline, click the Text button in the Extras palette
and drag a preset style from the palette to the Preview
area. Change the default text by double-clicking the text
frame in the Preview area and set its font and style as
desired in the Properties palette.
STEP #12: To add clip art to any slide, click the Graphics
button in the Extras palette and drag a selection to the
Preview area. Adjust its size by dragging its size handles or
in the Properties palette.
STEP #13: Click the Preview button above the Extras
palette for a larger preview of your slide show. Note that
in this mode, the play control strip will hide automatically
once the preview starts. Move the mouse to reveal the
controls at any time.
STEP #14: Click the Output button to save your slide
show in automatically-optimised formats for online or TV
viewing, email, or to burn to Video CD or DVD. Close the
slide show and save it to your catalog when prompted.
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STEP #8: Click the Add Media button in the Toolbar
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Eye-catching slide slows can be presented on disc or
screen. Upload it to your web site or share it by email.
STEP #1: In Photo Browser, click the Collections palette
tab to bring it forward. Click the Search box for the
Collection called Monterey.
STEP #2: Click Create, then Slide Show in the Creation
window and click OK. Leave the Preferences window at its
defaults and click OK again to open the Slide Show Editor
window.
STEP #3: Click Maximise to enlarge the Slide Show
Editor to full screen. Select the second thumbnail in the
Timeline. In the Properties palette, ensure the Enable Pan
& Zoom check box is selected. Note the green Start frame
appears in the Preview area.
STEP #4: Drag the corner handles and the frame itself
until the green frame surrounds only the area wanted
on screen when the slide first appears. Click the End
thumbnail in the Properties palette and drag the corner
handles and the red End frame in the Preview area until
the red frame surrounds the area you want on screen at
the end of the slide’s time on screen.
STEP #5: To add more movement to the same slide,
click the Add Another Pan & Zoom to this Slide button
in the Properties palette. This allows panning from one
person to another in close-up, zooming out to a wide
shot of the photo or panning and zooming into three
or four people in the same photo. It’s easy to create as
many moves as desired on one slide as the previous End
position is automatically set as the Start for the next move.
STEP #6: Adjust the second End frame as in the last
step. An extra slide is added to the Timeline automatically
each time a new pan-and-zoom is added to the same
picture with a link icon signifying they are the same
photo.
STEP #7: Click the first thumbnail on the Timeline to
move back to the first photo. Click Play to preview the first
frames with your new pan-and-zoom effects.
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Automatic red eye removal, simple skin tone correction and sharpened fast fixes
make fine-tuning every facet of a photo fast and easy. Now with Photoshop Elements
MORE INFO!
4.0, you can keep your photos at your fingertips with new ways to find and view them, including
face finding, advanced searches and enhanced folder organisation. Present your photo ingenuity to audiences
via dynamic slide shows, one-click online printing, enhanced Photo Mail and more.

Adobe Premiere Elements 2.0
Cut to the Creativity

A$169
NZ$159

Adobe Photoshop Elements 4.0 PLUS Adobe Premiere Elements 2.0
The Best of Both Worlds
Two powerful, intuitive products in one affordable package. Edit, organise and show
your photos in creative and entertaining ways. Create home videos like a Hollywood
pro. Plus-using both products, you can burn your photo slide shows to DVD and save
your DVD menu designs as templates to use again and again.
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inc GST
The latest version of Premiere Elements has everything you need to create homeex GST
made videos that thrill. Mixing superior control, ease of use and reliability, Premiere
MORE INFO!
Elements 2.0 automates tedious tasks so you can concentrate on your creativity.
Import video clips from any digital video device, then experiment with hundreds of professional
transitions and effects. Burn videos to DVD, complete with cusom menus for that personal touch or transfer them
to a portable video player for viewing anytime, anywhere.
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A$169 inc GST
NZ$159 ex GST

EFFECTS

Greater Power and Simplicity

A$249 inc GST
NZ$239 ex GST
MORE INFO!
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Adobe Photoshop Elements 4.0
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Edit your photos, create customized DVD’s and amaze everyone you
know with photos and movies created by you. Let the fun begin.
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AMAZE your friends. Even the really creative ones.
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Use familiar commenting tools including a highlighter, sticky notes, pen, strikethrough, callout,and more

•

Enable anyone who uses free Adobe Reader 7.0 software to actively participate in document reviews

•

Use digital signatures for faster electronic approval

•

Apply advanced document control and security

•

Create PDF forms that allows you to include business logic, such as calculations and data validations

Supported by Adobe Systems

Did you miss the Adobe
Creative Suite 2 Roadshow?

SYDNEY: 1-4 November, 2005

Don’t worry we filmed it! Well, some of it!

Join the leading Creative Suite experts in Sydney November 1-4 and
see the NEW Creative Suite 2 in action.

See for yourself a short overview of the
exciting new features in Adobe Creative
Suite 2 including updates to Photoshop,
Illustrator, InDesign and GoLive

Digital Media Festival
MORE INFO!
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If you use any one of the Creative Suite products (Adobe Photoshop,
InDesign, Illustrator, Acrobat or GoLive), this will be a valuable
show. If you use two or more of these applications, this is an
event you cannot miss!
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Assemble electronic or paper files—even Web sites, and e-mail—into reliable PDF documents

450,000+
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•
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Join us to find out how you and your co-workers can work together better with Adobe Acrobat 7.0 Professional.
Acrobat 7.0 Professional software lets your team share, mark up, review, and archive complex documents
easily and effectively. In this seminar, you will learn how to:

HOLLYWOOD

An Official Adobe Event
SYDNEY: 3 November, 10 November, 25 November, 1 December and 8 December

The Creative Suite Conference
MORE INFO!

MORE INFO!

Supported by Adobe Systems
SYDNEY: 6-8 December, 2005
This year’s show includes
special FX presentations from
the upcoming Harry Potter &
The Goblet of Fire, Lucas Film’s
Revenge of the Sith and Pixar,
creators of The Incredibles.
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Get on the same page with Adobe Acrobat 7.0
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“Photoshop enables me to cross the traditional boundaries of photography, illustration
and design. One of the biggest advantages of working digitally is that I take control of the
whole production process from beginning to end without the need for outsourcing.”
Starting in an ‘old school’ fashion, Luzette creates rough pencil sketches of her designs
before setting out to photograph the various individual components of her illustrations.
As an alternative to a camera, she makes use of a flatbed scanner to capture not only
flat artwork but also 3D objects, believing “the scanner is a much overlooked and highly
under-rated digitiser of all things interesting.”
Next, the base images are imported into Photoshop and compiled together in a single
document of separate layers. At this point most users would erase or ‘select and delete’
the areas of each layer that they didn’t want. Instead Luzette removes unwanted detail
from view using a layer mask. This non-destructive technique maintains all the pixels of
the original layer but hides unwanted areas. The beauty of this way of working is that the
hidden picture parts can be restored at any time by editing the layer mask.
Similarly, rather than reaching for the Opacity control Luzette merges various
illustration components invisibly by changing the way that the layers interact.
“Achieving seamless montage blending is so simple it’s almost an anticlimax when I
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Her initial interest in digital photography was sparked when she found it was easy to
replicate the effects she was producing in the darkroom right on the desktop. However, it
was only after diving headlong into Photoshop that she realized the opportunities and
possibilities beyond traditional media:

HOLLYWOOD

AIPP (Australian Institute of Professional Photographers) Photographic Illustrator of
the Year for 2005 and 2004, Luzette Donohue understands just how well Photoshop’s
blending and layering technology is suited to creating exciting montages. Describing her
work as a mix between illustration and photography, many of the images she makes are a
careful combination of seemingly unrelated objects in a single composition.
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Only a decade ago, montage artists relied on scalpels and glue to add/subtract images
on single layer, flat photographs. Now, with the multi-layer structure of Adobe Photoshop,
combining several photos together in the one composition is a much simpler editing task
offering far ranging possibilities.
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Story by Philip Andrews
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Photoshop

PHOTOGRAPHER MASTER SERIES
Luzette Donahue - Master of Montage
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3

Aim for best practice so you don’t inadvertently limit your options. Be sure to consider
factors like output resolution and colour depth, and, where possible, use non-destructive
editing techniques e.g. choose to mask not select and delete, and save multiple versions
of working files (RAW source files, master files with layers, flattened print ready files etc.
Photoshop is simply a tool and everyone has their way of using it. Don’t immediately accept
well-intended advice regarding the ‘correct’ way of achieving a particular result. There’s
always at least five ways of doing something. Take the time to try different approaches
and compare the results, then choose the best for your. Don’t be afraid to experiment and
try something new.
For perfect blends don’t overlook the drop down list of blending modes that appears
throughout Photoshop. It appears in the layer palette as well as the Brush and Fill options
dialogues.

ABOUT LUZETTE DONAHUE
As well as being an award winning photographic
illustrator Luzette is the creative director of Art Now
(www.artnow.com.au) and is a regular contributor to
Australia’s own Better Photoshop Techniques magazine
(www.betterphotoshoptechniques.com).
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Luzette’s Top Three Photoshop Tips

EFFECTS

Despite the key role that Photoshop plays, Luzette stresses great digital tools are
no substitute for creativity and good design. “Photographers should concentrate on
improving their base photographic skills such as camera and lighting control rather than
relying on Photoshop to correct and compensate poor technique.”

HOLLYWOOD

“To control your blending even further you can set which areas of an image layer will
appear or disappear by experimenting with the layer blending sliders at the bottom of
the layer style window. Adjustments to the appropriate arrow will mean either shadows or
highlights can be hidden or revealed.You can even split the tiny arrow indicators by holding
down ALT to achieve a more subtle blend between your composition components.”
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Photoshop
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share the secret with other Photoshop artists. Simply change the way a layer interacts with
the one below by swapping the layer blending mode from normal to one of the many
contained in the drop down list at the top of the layer palette. Alternatively you can access
this list and more blending controls by double clicking on the layer and opening the layer
style dialogue box. To get a good idea of how each setting will look you can preview the
effect of each mode by using the up and down arrows to scroll through the list.
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Step #1:

Collect the raw ingredients for your montage.
Anything you can photograph or scan has creative potential.
Peeling paint, rusted roofing, aged billboards and stone walls are all
wonderful background elements. Try using your desktop scanner
to digitise natural objects like leaves, shells, insects and feathers
as well as the usual two dimensional items such as handwritten
letters, old photos, deckled paper and children’s finger paintings. If
you catalogue these files systematically it won’t take long
before you have a library of Photoshop pictures.
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Luzette Donohue reveals how she uses Photoshop’s layers and blending modes to
create this stunning image that was part of her award winning folio of montaged photos.
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Photoshop

Creating Luzette’s Buddha Illustration Step by Step
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TRIAL PHOTOSHOP CS2 FOR 30-DAYS
Register now to receive a FREE Trial DVD
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To blend all of
these separate layers, don’t just
reach for the opacity slider. Rather
than see through them, you want
to make the layers interact. Use
the drop down list of blending
modes at the very top of the layers
palette. This list provides you with
a range of special effects made
possible by changing the way the
pixels of your currently active layer,
interact with the pixels on the layer
beneath.
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Step #3:
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Start with a blank canvas and transfer the
raw ingredients you’ll use to form the foundation of your
background. Often very few layers are required to produce
quite a complex result. The challenge is finding layers to
complement each other.To give your finished piece a tactile
appearance, choose elements that provide texture. In this
example both hessian fabric and paper provide fine detail.
Incorporate objects with interesting shapes that contribute
to the design of the image and result in a cohesive piece.
Importantly, resist the temptation to add too much! A cluttered canvas can reduce the
impact of the final image. Plus, there is always the possibility that your computer may
grind to a halt under the strain of a great many layers.

450,000+
IMAGES

Step #2:

lended. It
very subt
le result.
Multiply:
Ov
Step #5: On occasion, even advanced blending techniques don’t
effect. If t erall, Multiply will
produce the desired result. It may be the part of the layer you want to reveal that
he
pr
however re is black in the la oduce a darker
is
disappearing and the area you don’t
wh
ye
ing colou ite will have no e r it will stay black,
require that is highly visible. Perhaps
ffe
rs.
integratin This can be partic ct on the existwhat
you need is a negative. Go to the
ularly use
g black te
ful when
xt.
Image menu and choose Adjustments >
Differenc
e and Exc
Invert.
In this illustration the kanji, originally
lusion: Bo
no other
t
h
an
written in black ink, has been inverted to
m
very usef d invert the base c odes behave like
ul negativ
produce white writing so that it doesn’t
olours to
e.
produce
a
divert attention from the main subject.

NEW
PRODUCTS

MASTER
PHOTOSHOP

TUTORIAL
PHOTOSHOP

450,000+
IMAGES

EFFECTS

Explained

HOLLYWOOD

Layer Ble
nding Mo
des

RED TAPE
SLASHED

Step #4: The Layer Style dialog box
also offers further control over which parts of
a particular layer to blend and to what degree.
Experiment with the two sliders. If you grasp
the black end of the slider and move
it to the right, the dark areas
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Photoshop

You can choose each effect in turn but be aware that every change will be recorded
on your history palette. The danger of this isn’t obvious until you decide to return to your
starting point after much experimentation and discover it is no longer listed in your history
palette. To avoid this, double click on the layer itself and open the Layer Style dialog box.
Under the heading General Blending you’ll find the same list of blending modes. Here
you can drop down the list, choose one and then use the up and down arrows on the
keyboard to scroll through while previewing the results (but first move this rather large
dialog box aside).
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Working in layers and utilising non-destructive editing skills gives
you peace of mind and the luxury of experimenting with your artwork until you are
completely satisfied. Rearranging the order of layers by dragging and dropping on
the layers palette can drastically alter effects. So too can manipulating the contrast,
colour or saturation of individual layers. A curves adjustment layer was applied here to
enhance the yellow in the image and refine the final colours.

Step #8:

Learn quickly and efficiently with this superb easy-tonavigate compilation of all the menus, tools and features
offered in the latest version of Adobe Photoshop, CS2.
Philip Andrews and Peter Bargh share with you their
extensive knowledge and experience of Photoshop in
this excellent resource.

Photoshop CS2 Essential Skills is an inspirational and
user-friendly guide to creative image editing, offering a
highly structured educational approach to photographic
learning. The package is approached in a clear, step-bystep style, with examples which accompany each feature
discussed, assignments and tutorials to aid the learning
process. The accompanying CD and
website, www.photoshopessentialskills.
com offer additional teaching and
learning support materials. They include
all of the images and presets used in
the text, 2½ hours of QuickTime movie
tutorials to support the practical activities,
and a series of additional short ‘Quick
Fix’ movie tutorials to cover some of the
problem areas frequently encountered by
newcomers to image editing.

Structured in a clear and simple
column format for you to dip
into, or work through feature by
feature, Adobe Photoshop CS2
A-Z covers each area concisely
and includes directions to
related topics. Solve problems
as you work avoiding the
frustrations and struggles that
can accompany time-sensitive
projects. August 2005, 0 240
52002 5, PB, 256pp, Focal Press
A$55.00

July 2005, 0 240 52000 9, PB, 384pp, Focal
Press $66.00

ph 1800 263 951, fax 02 9517 8963
Email: customerserviceau@elsevier.com.au.
Website: www.elsevier.com.au/photography

Photoshop CS2: Essential Skills

To order call Elsevier Australia
Customer Service

Register now to receive a FREE Trial DVD
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TRIAL PHOTOSHOP CS2 FOR 30-DAYS

Adobe Photoshop CS2 A - Z
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One final tip for creating a successful montage – don’t
concentrate on techniques at the expense of composition. It’s all too easy to
become engrossed in the fabulous effects Photoshop makes possible and to
forget what makes a good picture. When in doubt, save your file and come back
to it after a short break. Then assess it when refreshed and ask a friend for a
second opinion. A viewer will assess the image on its merits, not the number of
hours you’ve put in to create it!
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The subject is the statue of Buddha, originally photographed against a plain background using natural
light. The background wasn’t required so it was hidden using a layer mask. This was created quickly by selecting the
background with the magic wand and choosing add layer mask from the layer menu.
This menu command gives you the option of hiding or revealing the selected area.
By default, the mask is linked to the layer and a thumbnail of it appears in the layers
palette. At any time you can return to edit, disable or permanently apply this mask.
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Step #6:
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Creative
Adobe Adds Four New Image Feature:
Collections to Stock Photos Adobe
Stock
Photos
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The new collections along with the increases to existing, bring the total number
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of stock images to over 450,000. They give Adobe Creative Suite 2 customers a
huge variety of royalty-free images to choose from, making it even easier to find
the right image without leaving the application.

Creative Suite 2 software application. Over one m illion low-resolution comp images
have been viewed from Adobe Stock Photos in the first 90 days of operation.
Check out the next two tips and give Adobe Stock Photos a try for yourself.

00
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downloading an un-watermarked, low-resolution version into their favourite Adobe
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Adobe Stock Photos allows customers to evaluate an image before licensing by

Adobe Stock Photos as part
of your InDesign Workflow
Step #4:

Step #1: From InDesign, begin a search by choosing File > Browse (or by clicking Adobe
Stock Photos in your Favorites pane in Adobe Bridge).

Step #2: Perform a general search using the text box, or refine your results using the
Advanced Search. Your searches are automatically saved.
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Step #3:
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Creative
Feature:

Step #4: Once you choose an image, simply drag it from Bridge directly into your InDesign

EFFECTS

resolution image comps. Then view the downloaded comps by clicking the Downloaded
Comps icon.

beside the file name to indicate that the image is an Adobe Stock Photos comp image.
Choose Link File Info in the Links palette menu to view the file’s metadata.

Step #6: After the layout is approved, purchase the high-resolution image to replace the
comp directly from InDesign by choosing Purchase This Image from the Links palette menu.
The image is automatically added to your shopping cart and presented to you. To purchase
multiple images, click the Shopping Cart icon in Adobe Stock Photos.

Step #7: Log into your account or sign in as a guest to complete the purchase.
You can download the high-resolution image immediately or choose to download it at a
more convenient time. All downloaded, purchased images are placed in your Purchased
Images folder located in the Favorites panel of Bridge under Adobe Stock Photos.
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Step #5: When a comp is placed into InDesign, a special icon in the Links palette appears
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file. Select Switch To Compact Mode in Bridge to shrink the window so that it can float above
other applications like a palette.
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Step #3: As you view the search results, click Download Comp to download free, low-

Creating a swatch library from a stock photo has traditionally been a tedious task, requiring you to
repetitively drag the Eyedropper tool across the image to collect all the colours you may want to use. But
the new Adobe Illustrator CS2 Live Trace tool makes this process simple, fun and fast.
Live Trace automatically turns placed images into beautifully detailed vector graphics and creates a
swatch library for the image. You can then easily share the swatches with any other Adobe Creative Suite 2
component by saving the swatch library for exchange.
To create a swatch library from a stock photo:

NEW
PRODUCTS

MASTER
PHOTOSHOP

TUTORIAL
PHOTOSHOP

Using colours in a stock photo
as a shared palette across
Adobe CS2 applications
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Adobe
Stock
Photos
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Creative
Feature:

Step #2:

Step #2: Set the Tracing Options. Choose Object > Live Trace > Tracing Options to open the Tracing
Options dialogue box. Select Color 16 from the Preset menu. If you want more than 16 colours, select the
number of colours in the Max Colors text box. You can select up to 256 colours. The more colours you
select, the more subtle the colour shades in your palette will be.. Select Output to Swatches. Custom now
appears in the Preset menu. However, your results will match your original selection.

Step #3: Click Trace. The colours are output to your default palette as spot colours.
Step #4: Select Save Swatches For Exchange from the Swatches palette menu, type a name for the
swatch library, and then save it in an easily accessible location.
You can now load the swatch library into the Swatches palette for any other Adobe Creative Suite 2
component. Your shared colours will appear exactly the same across applications as long as your colour
settings are synchronised.
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Step #4:
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as a 72 ppi resolution.
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Step #1: Place the image in Illustrator. For fast tracing, it’s best to use an image with a small file size, such

In order to recreate the high-flying world of Howard
Hughes in The Aviator, Scorsese required the use of
over 400 visual effects shots.
Stunning visual effects on a modest budget
To oversee this painstaking effort, Scorsese turned
to Oscar-winning visual effects supervisor Rob
Legato. In order to cost-effectively create the most
realistic effects possible, Legato used a hybrid
approach including traditional techniques such as
miniature models in forced perspective and highend computer graphics tools.

person can do all these things,” says
Legato. “Before After Effects there
were other powerful effects tools,
but who could take the time to learn
a proprietary software package like
the ones used at big visual effects
houses?”

Using desktop systems also allowed Legato to
remain hands-on throughout the process. Instead
of verbalising his requests to a computer artist and
hoping the shot would come back as he intended,
Legato could play with the material himself.

“This was a big budget movie, but the effects So too, quick changes were possible based on
budget wasn’t huge – it had to look like it was Scorsese’s feedback of the material.
though,” says Visual Effects Producer, Ron Ames.
Additionally, the desktop environment let Legato

Allow the Effects Team a more hands-on,
integral role in the filmmaking process
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Produce exceptional effects on a modest
budget

Solution:
Use inexpensive desktop systems and tools
like Adobe After Effects and Photoshop for
previsualisation, effects, colour, timing and
pipelining

EFFECTS

Amazingly, more than 300 of The Aviator’s 400
effects were created by Legato, effects editor
Adam Gerstel and a team of independent visual
effects artists using desktop computers loaded
with Adobe After Effects, Adobe Photoshop and
Martin Scorsese is renowned for eliciting searing, other off-the-shelf software packages.
iconic performances from his actors; for virtuosic A hands-on approach, on the desktop
and unflinching camerawork; and for productions
“What’s revolutionary is that one
rich in both lush detail and gritty realism.

Visual Effects in Scorsese hit piloted
by independents flying with Adobe
After Effects and Photoshop

Challenge:

HOLLYWOOD

MORE INFO!

TUTORIAL
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www.miramax.com/aviator

Benefits:
Scorsese could ascertain what his scene ideas
would look like before committing to more
expensive live-action, model or CGI shots
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The

Film: The Aviator

Hundreds of effects shots were created
inexpensively
Visual effects artists could experiment with
desktop tools to realise their ideas
Tool Kit:
Adobe After Effects Professional
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on Aviator

Adobe Photoshop CS
Custom PCs running Microsoft Windows XP
Professional
Apple Power Mac G5’s running Mac OS X
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There are
all sorts of
helpul documents on the
Adobe website to help
you get started. Take a
look at them and then
have a go at bringing your
ideas to life.
MORE INFO!

And don’t miss the
video tips on the
following pages...

Many of The Aviator’s effects shots, however, are
more subtle than the spectacular aerial stunts.
For instance, Scorsese wanted The Aviator’s
colour palette to reflect the look of movies from
the period portrayed onscreen. Hence, when
the action is set in the years 1927-1937, the film
emulates Technicolor’s two-colour dye transfer;
for the period 1937-1947, the film’s look changes
to Technicolor’s three-colour dye transfer system.

Images copyright © 2004 Miramax Film Corp. and Initial Entertainment Group
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Colour timing using Photoshop

anymore – it’s another tool, like a
special lens or a filter.”

EFFECTS

Virtually ubiquitous within the digital effects
community, After Effects became a common
format or “pipeline” for transporting images
between the production’s various departments
and outside vendors.“Everyone has their own pet
system,” says Legato, “but everyone has a copy of
After Effects. It’s a standard tool.”

HOLLYWOOD

Why not
download
the 30-day trials of Adobe
After Effects, Adobe
Premiere, Adobe Audition
and Adobe Encore DVD?
DOWNLOAD!
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Interested in trying
your hand at video,
but not sure where
to start?
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Legato was able to “previz” the palettes by
scanning black-and-white stills and using Adobe
Photoshop to digitally overlay cyan, magenta
and yellow filters, digitally emulating historic
Technicolor colour processes. “The software can
Instead, Legato used After Effects to “previsualise” be used in ways never imagined by the people
many of the scenes before and during production, who invented it,” observes Legato.
allowing Scorsese to see what the final product The future of filmmaking
would look like before committing to more
expensive live-action, model or CGI shots.“It’s like And there was another benefit of using a PCan animated version of storyboarding,” explains based system: Legato could work whenever and
wherever he needed. “I could whip something up
Legato.
in my hotel room on my laptop and then show
For example, in one scene where Leonardo Marty on the digital projector in his screening
diCaprio, as Hughes, directs a dogfight from room,” recalls the visual effects supervisor.
the cockpit of a biplane, it was essential to the
integrity of the film that the aerial choreography Ames predicts that the future of effects is defined
match the battle as it later appears in a clip of by inexpensive computers and non-proprietary
the Hughes film, Hell’s Angels. Consistency was software as used on The Aviator:
possible using a digital video camera, After Effects
“This is how all filmmakers will work
and Alias|Wavefront’s Maya software.
going forward. It’s not an effect
and his team play a far more integral role during
the filmmaking process, notes Ames. “The way it
has usually been done is to shoot the main unit
and leave a space for the effects, so the effects
team is not part of the main unit.”
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Step #1: Import an audio file. In a new project, import an audio source file, (e.g. a WAV, MP3,
AIF or MOV file). Music with a strong beat works best. Create a new composition and limit the
duration to a few seconds to speed up processing and previewing times. Add the audio file to
the Timeline window.
Step #2: Convert audio to keyframes. Select the audio layer and choose Animation > Keyframe

Assistant > Convert Audio to Keyframes. A new null layer called Audio Amplitude appears in
the Timeline window with keyframes that contain values for the audio’s amplitude.
To view these keyframes, select the Audio Amplitude layer in the Timeline window and press
the U key on your keyboard. Leave the layer expanded.

Step #3: Create a text layer to animate. While you could use any type of source footage, text
layers illustrate the capabilities of audio amplitude keyframes exceptionally well.

Select the Text tool in the Tools palette and click in the Composition window to create a new
text layer. In the Character palette, choose a font and a font size that’s suitable for the size of
your composition. Leave the remaining controls at their default settings.
Click in the Composition window and type a single word. Use the selection tool to reposition
the text layer as needed.
VIEW MOVIE OF
THIS TUTORIAL

Considering your
own Pod Cast?
Adobe employee, Kevin Goldsmith recently
published a tutorial on his blog for creating
a Pod Cast using Adobe Audition 1.5.
Kevin’s blog entry can be found
at: http://blogs.adobe.com/kevin.
goldsmith/2005/10/adobes_first_po.html
Download the 30-day trial of
DOWNLOAD!
Audition today and give it a go!
Check out all of the Adobe Blogs at
http://blogs.adobe.com
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Animations and visual effects synched to
music and images glowing and pulsing with the beat
in Adobe After Effects. To get things moving in time, you create
keyframes from an audio file and use them to animate effects:
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IT’S A DIGITAL DISCO.
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import your footage into After Effects

Video compression is not used in
creating a filmstrip file, so filmstrip files
can be very large. You can however
break the filmstrip file into any number
of smaller files.
A filmstrip opens in Adobe Photoshop
as a series of frames in a column, with
each frame labelled by number, reel
name and timecode. The number of
frames displayed depends on the
duration of the footage and the frame
rate selected when the filmstrip is
rendered.

on your first frame, jump to the one-second mark. Use
the Reshape and Transform tools to match the masks
Step #5: On the bottom layer, apply Hue/Saturation. again. Repeat this process at the two-second mark.
Effect > Adjust > Hue/Saturation. Turn the Master
Saturation down to -100%. Turn off the Visibility for Step #12: Silhouette Roto - like the Mask tool in
the top layer for a moment by clicking the eyeball After Effects - will take care of the in betweens, but
icon in the A/V features of the timeline. Your bottom quite often they will not match. Jump to the 15second mark, match it up, then back to the 7 or 8layer should now be completely black and white.
second mark, match it up and so on. Before long, your
Now is where the real work begins.
masks will all match up.
Step #6: Turn the visibility back on for the top Step #13: Press Play to preview and make all
layer of footage and select it. Apply Silhouette Roto. necessary adjustments.
Effects > Silhouette Roto. Look at the screen shot of
the timeline above and ensure the right effects are on Step #14: If satisfied with your rotoscoping, you
may want to apply a bit of a feather to your masks.
the right layers.
Click the Feather tool in the Toolbar and click your
Step #7: Go into the features of Silhouette Roto by mask layers to apply.
clicking the Options link in the Effects Control window,
Step #15: Change the view of your project, so you
or under effect in the timeline.
can see the masked items by changing the View to
Step #8: Check the left side of the Silhouette Roto composite in the upper left corner of the interface.
interface. You will see the toolbar which has several
Step #15: Happy with it? Let’s output. File > Export
masking or roto tools.
> Shapes > After Effects Masks.
layer. Duplicate the layer (Command+D/Alt+D)
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In Photoshop, export the Filmstrip
format from Adobe Premiere Pro or
After Effects. Render all or part of a
composition as a film-strip, a single
file that contains all the frames
of a composition, or portion of a
composition.

Step #4: Go to the Timeline and select your movie Step #11: After all of the masks have been drawn

HOLLYWOOD

Rotoscoping involves painting on
individual frames over a series of
frames to create an animation or to
remove unwanted details in your
footage - in either Adobe After Effects
or Adobe Photoshop.
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What is Rotoscoping?

want coloured. Each area masked will get its own layer
Step #2: Let’s assume that you’re using the full in the timeline. Keyframes will be automatically added
duration of the clip. Drag your clip in the footage when each masks is put on a layer. Each new mask will
window onto the Create a New Composition icon. default to a name such as “Circle2” and “Circle3”. These
This creates a new composition that is the same size can be renamed.
and duration of your footage.
Step #10: On the right side of the interface, each
Step #3: To rename the composition, select it in the layer is listed with switches such as mask colour,
motion blur, visibility and lock.
project window and hit Return. Rename.
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Step #1: Create a new project in After Effects and Step #9: Use the tools to trace the areas that you
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Give your footage
the “Sin City” look
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Until now, the majority of Asutralian SMB’s have used static
forms to interact with Government agencies via the www.
business.gov.au website. Businesses would download forms
from the site, print them, then complete and return them to
the relevant government agency.
According to Paul Griffin, General Manager, Business Entry
Point Branch, Department Industry, Tourism and Resources,
the new Adobe Intelligent Document Platform will reduce
the burden of compliance reporting for business, making
interaction faster and forms easier to complete.
“The site receives close to 250,000 visitors and more than
3 million forms are downloaded every month. We conducted
an extensive evaluation process during the 2004/5 financial
year to find a mroe efficient electronic forms platform that

“This means that every Australian SMB can
leverage the rich functionality of the Adobe
intelligent form - without any cost to the
business - and can work with that form both
on and offline anytime, anywhere,” added Mr
Griffin.
He said it was an ideal solution,
allowing Australians to deal with all
levels of Government in a consistent way
electronically.

Paul Griffin, General Manager,
Business Entry Point Branch,
Department Industry, Tourism and
Resources

“It is a mechanism that will transform
the flow of information and drastically improve the public’s
interactions with Government agencies.”

Craig Tegel, Managing Director Adobe Pacific, said the
Adobe solution would save considerable time and money for
the department and Australian businesses.
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“It is a mechanism
that will transform the
flow of information and
drastically improve the
public’s interactions
with Government
agencies.”

EFFECTS

A large advantage of the Adobe solution
is the ubiquitous nature of the free Adobe
Reader.

HOLLYWOOD

The Business Entry Point website provides Australian SMBs
with access to a broad range of information and services,
including OH&S reports, development applications and BAS
statements.

would reduce red tape, save Australian SMBs time and
money, lower administrative overheads and offer a consistent
and easy-to-use solution. The only solution that met and
exceeded each criteria was the Adobe Intelligent Document
Platform.”

RED TAPE
SLASHED

The Australian Government Department of
Industry Tourism and Resources has chosen
the Adobe Intelligent Document Platform to
provide Intelligent Forms for its Business Portal
website ‘Business Entry Point’, saving time
and money for Australian small-to-medium
businesses (SMBs).
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Red Tape Slashed for SMBs with Government switch
to Intelligent Forms
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Red Tape Slashed for SMBs with Government switch to Intelligent Forms
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Adobe LiveCycle :

EFFECTS
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“The business logic, client side validation,
and dynamic nature of these Adobe PDF forms
means they can be downloaded, completed
offline and then lodged later. The client also has
and retains a copy of the form and its data for
their records.”

RED TAPE
SLASHED

The intelligent forms can also be securely
pre-filled with common information about the
individual or business.

CLICK ON THE IMAGE TO VIEW THE VIDEO
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The Adobe LiveCycle forms will be
implemented by Adobe’s implementation
partner Indigo Pacific. It is anticipated that
100 PDF forms will be initially available, with
a further 200-300 ‘smart-enabled’ relatively
quickly. The remainder will be transitioned
across the Adobe LiveCycle Forms solution in
the next two years.
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“It will allow an Australian SMB to store a
group of transactions such as BAS and OH&S
quarterly statements as favourites, saving time
and hassle in repeatedly filling out the same
information every quarter,” added Mr Tegel.
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STEP #6: The Tracker can also convert the feed

to PDF for you, so you can read it offline at your
leisure, or even print it out. Simply right click on
the “Adobe Pacific Events” news feed and Select
STEP #2: Select Services > Subscribe.
“Convert to PDF” from the menu. Acrobat will
STEP #3: A dialogue button asks for the URL for create a PDF of the news feed for you.
the RSS feed. The Adobe Pacific Events RSS Feed You can add as many RSS feeds as you like
URL is http://events.adobe.co.uk/events_pa.xml. to the Tracker, below are a few you may find
Enter the URL and Select OK.
interesting.

TRIAL ACROBAT 7.0 FOR 30-DAYS
Register now to receive a FREE Trial CD

USEFUL RSS NEWS FEEDS
Adobe Blogs: http://blogs.adobe.com/index.xml
Adobe Events: http://events.adobe.co.uk/events/events_pa.xml
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whenever we add a new event. What’s more ##
will appear in your toolbar whenever the news
updates - so you know to check the Tracker.

HOLLYWOOD

STEP #5: This list will automatically update
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The Tracker keeps all the information on PDF
reviews that you may have either initiated or
participated in. Along with this, you also are able
to subscribe to RSS Feeds.

Feed for Adobe Pacific, expanded automatically.
You now have an active connection to our list of
events.
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STEP #1: In Acrobat 7.0 select View > Tracker.

STEP #4: The Tracker now shows the Events
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RSS feeds are basically web pages without any
formatting that can be read by anything that
supports RSS. Instead of constantly revisiting
your favourite website (like http://www.pacific.
adobe.com/events) to see if anything is new,
you can monitor an RSS feed and it will tell you if
anything is new, similar to email.
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Use Acrobat 7.0’s Tracker to Read RSS News Feeds
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Adobe Acrobat :

Creating a Digital ID

Creating a Digital ID allows people to encrypt documents for your eyes
only. If you have Adobe Acrobat or are filling out an Adobe Reader
Enabled form using Adobe Reader 7.0, then you can also digitally sign
files instead of printing them.

If you want to send someone a secure document, they need to follow
this procedure:

Encrypting: Protect documents so that only the people you select can
open the protected files. This stops people passing on your documents
to other people. Even if you use a password, it can be passed along too!
Using Digital ID encryption ensures that only the desired recipients can
view the document.
Digital Signing: Why print and sign the document with a pen when
you can digitally sign the document and keep it digital? Better than
pen and paper, Adobe Reader and Adobe Acrobat can detect if the
document has changed after signing, allowing you to see exactly what
was signed.

STEP #4: Reader/Acrobat informs you that you are making a SelfSigned Digital ID and it is up to you to manage it. Click Next.
STEP #5: Now choose where to store your new ID. If you create a
standard PKCS#12 ID you will need to enter your password in each
time you need to sign. However, if you choose the Windows Certificate
Store then Windows will link the ID to your Windows log in account.
Mac users will only see the PKCS option where as most Windows users
should be ok with Windows Certificate Store. Make your selection and
click Next.
STEP #6: Enter your details, then click Finish. Your digital ID has been
created.

EFFECTS
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STEP #3: Next you need to specify the type of Digital ID you wish
to create. In this case, you want to make a new ID to share between
friends and colleagues so use a Self-Signed Digital ID. You need to distribute a Self-Signed ID yourself, whereas a third-party ID is managed
by a Digital ID Provider. Select Self Signed Digital ID and Click Next.

RED TAPE
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Certify Documents: Provide a way for your colleagues to make sure
you created the documents you sent them and that they have not
been altered.

STEP #2: Make sure you have the Digital IT tree selected on the left
and then click “Add ID”.
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Here are some of the reasons to create a Digital ID:

Document menu (under Advanced in Adobe Acrobat).
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While creating a Digital ID may seem daunting, once created they are
very easy to use and provide an easy way to protect your documents.

STEP #1: In Adobe Reader 7.0 select Security Settings from the
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How to create Digital IDs in Adobe Reader 7.0
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Using Digital IDs in Adobe Reader 7.0 and Adobe
Acrobat 7.0 for Secure Communications
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select the Digital ID that you just created and
select “Export Certificate”. Select “Email the data
to someone” and Click Next.

STEP #2: Enter the email address of the per-

son you wish to send your public key to then
click “Email”.

STEP #2: Choose which options you trust and
Click OK.

STEP #3: The Certificate is now imported…

and should be viewable in the “Manage
Trusted Identities” dialogue (Adobe Acrobat
Users: Advanced > Trusted Identities, Adobe
Reader Users: Document > Trusted Identities).

STEP #4: You have now successfully shared

STEP #2: Click New.
STEP #3: Use Public Key Certificates.
STEP #4: Follow the Wizard steps to create a
new security policy.

Digital Sign or Certify a
Document
STEP #1: Document > Digital Signatures >
Sign this document.

STEP #2: Follow the Wizard to either Digitally
Sign or Certify the document.

your Digital ID to enable secure document
transfer using Adobe Acrobat.

STEP #3: A new email message is created with

an FDF file containing your public key as the
attachment. You can customize the email message if you wish and when finished click “Send”.

EFFECTS

button.

document.
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STEP #1: In the “Security Settings” window

STEP #1: Click on the “Set Contact Trust…”

STEP #1: Document > Security > Secure this

HOLLYWOOD

If you receive an email like the one above with
a Public key certificate attached, simply double
click it to launch Acrobat. You should see a dialogue box where you will need to specific the
level of trust you give the sender’s Digital ID.
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Above you created a Digital ID that, currently,
only you know about. For other people to
encrypt documents for you to view they need
your “public” key. The public key is part of
your Digital ID that you share when you wish
people to send you secure documents. We will
be sharing the certificate via email. Reader
or Acrobat do not send your Digital ID (your
private key) but just enough information for
the person at the other end to encrypt a document so that only you can read it (your public
key).

Try Securing A Document in
Acrobat Using Their Digital ID
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Importing a Public Key

TRIAL ACROBAT 7.0 FOR 30-DAYS
Register now to receive a FREE Trial CD
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Sharing Your Public Key
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Using Digital IDs in Adobe Reader 7.0 & Acrobat 7.0 for secure communications
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Forward the magazine to your friends, or
encourage them to register to receive the
magazine every quarter at:
http://www.pacific.adobe.com/magazine
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Don’t keep these tips to yourself!
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Summer Issue Date: January 2006
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Was there a story you particularly enjoyed,
do you have a tip, or know somebody using
Adobe technology in a unique way that
would interest our readers? Please send your
comments and ideas to jbrady@adobe.com
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Send us your feedback

